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Introduction 
Your users can save a lot of time and effort working with Excel if they know a few tricks and shortcuts. 
These valuable tips originally appeared in our Excel e-newsletter, which has now been beefed up to 
include powerful productivity tips for the entire Microsoft Office suite. To begin receiving this free, 
valuable resource every Wednesday, visit our e-newsletter subscription center. 
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Charts 
A macro that pulls source data from charts 
When building charts in Excel 97, many users reference information in other workbooks to keep 
spreadsheets fairly streamlined. But what do you do if a user complains that the data source has become 
corrupted or that the file is no longer available in the network? 
 
It's a little bit of a headache to read, but Knowledge Base article 137016 includes the full contents of a 
macro that can strip important data from the graphic elements of a chart. 
 
http://support.microsoft.com/support/kb/ARTICLES/Q137/0/16.asp
 
After creating the simple VBA macro, you only need to run it and drop the information into a worksheet 
called ChartData. Don't go volunteering this information to all of your users, but if a VP loses an important 
sales worksheet, you can pull out this nifty power trick and save the day. 

Shifting a scatter chart's axis 
In most cases, Excel's default behavior of making the x-axis and y-axis of scatter charts intersect at 0 is 
desirable. But sometimes, your users may want to change that intersection point. An obvious example is 
when a user needs to highlight just a selected number of years of data but doesn't want to create an 
entirely new chart. 
 
To reset an axis, follow these steps: 

1. Activate the chart for editing. 
2. Click to select the axis you want to modify. 
3. Choose Selected Axis from the Format menu. 
4. Select the Scale tab. 
5. Type a number in the Value (X or Y) Axis Crosses At text box. 
6. Click OK. 

Map your data—on real maps 
If you often analyze geographically based data in Excel, you should check out Microsoft MapPoint 2000. 
MapPoint lets you create customized maps, and you can arrange your data on a map to suit your needs. 
For example, MapPoint can show average household income demographic data (which is built into 
MapPoint) and then show your company sales data for the same regions. This can help you see trends in 
how your organization sells across demographic groups. You can save these maps, annotate them, and 
use them later. 
 
If your organization tracks anything by region, city, etc., take a look at MapPoint. It's also a great general-
purpose mapping application that will let you create maps for your Windows CE devices using Microsoft 
Pocket Streets. For more on MapPoint, visit http://www.microsoft.com/office/mappoint/. 

Customizing your workspace 
Change default worksheet options 
By default, Excel includes three worksheets in a new workbook. But if most of your users rarely use more 
than one worksheet per workbook, you can prevent Excel from generating the two extra worksheets. 
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Follow these steps: 
 

1. Go to Tools | Options. 
2. On the General tab, set the value in the Sheets In New Workbook box to 1, and click OK. 

 
The next time you create a new workbook, it will have only one worksheet. You can also increase the 
number of sheets per workbook. 
 
You can also use the Options dialog box to change the worksheet's default font. For example, to change 
the default font from Arial 10 to Times New Roman 12, follow these steps: 
 

1. On the General tab, select Times New Roman from the Standard Font drop-down list. 
2. Select 12 from the Size drop-down list, and click OK. 

 
You must restart Excel for your font changes to take effect.  

Opening multiple windows 
One of the most frustrating problems for Excel users is viewing all the information they need, especially 
because it often lives in different worksheets. Let your users know about this simple way to view multiple 
sheets, and they'll love you forever. 
 

1. Click on the tab of the worksheet you want to view. 
2. Choose New Window from the Window menu. 
3. Repeat this process for each of the worksheets you want to display. (Excel opens each sheet in a 

window that sits on top of the previous one.) 
4. To see them all at one time, choose Arrange from the Window menu. 
5. Select Tiled, Horizontal, or Vertical. 
6. Select the Windows Of Active Workbook check box. 
7. Click OK. 

Creating a workspace in Excel 
Often, your users will be working with several workbooks at a time. They will be happy to know that they 
can arrange the workbooks, save them as a workspace, and then open everything at once in the viewing 
configuration they prefer. Here's how: 
 

1. With all the workbooks in the preferred positions, go to the File menu. 
2. Choose Save Workspace. 
3. Type a name for the file. 
4. Click Save. 

The next time your users want to work with those workbooks, they can go to File | Open and select their 
workspace. 

Change the default currency 
If your worksheet's formatting conforms to your regional settings, Excel's Currency button makes it easy 
to format currency values. This button uses settings from the Regional Options dialog box to set the 
default format. For example, if the Regional Options are set to English (United States), by default, the 
Currency button formats currency values for the United States. 
 
Follow these steps to change the Currency button's default county/region settings by resetting them in 
Control Panel: 
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1. From the Start menu, open Control Panel, and double-click Regional Language And Options if 
using Windows XP. If you're working with earlier versions of Windows, double-click the Regional 
Options icon. 

2. Select the country/region you want to use as the default from the drop-down Location list, and 
click OK. 

 
The next time you start Excel, clicking the Currency button will format the cells in the new format. 
 
In earlier versions of Windows, you may need to restart your computer for the changes to take effect. In 
addition, changing the region in Windows also changes the settings for time, date, and number formats to 
those used in that region.  

Faster access to worksheets 
When working with large workbooks in which all of the worksheet tabs are not visible, your users may get 
frustrated with scrolling to find the sheet they need. Here's a really quick tip to pass on. Right-click on any 
of the tab-scrolling buttons (to the left of the sheet tabs) and a shortcut menu will pop up. You can then 
select the tab you want. 

Keep a cleaner desktop when multitasking 
Are you one of the many busy Excel 2000 users who frequently have two, three, or more workbooks open 
at once? If so, you know that kind of multitasking can create a lot of screen clutter. In the Windows 
taskbar, you'll have an icon for each open workbook. Within the Excel window, you can navigate between 
workbooks by pressing [Ctrl][F6] or by opening the Window menu and selecting a workbook from the list 
of open files. 
 
Excel offers an option that can help you avoid screen clutter while keeping as many workbooks open as 
you like. To try it out, open three or four workbooks, and go to Window | Hide. When you do, Excel erases 
all traces of the current workbook from your screen. The workbook is still open, but you can't see it. 
 
To make a hidden workbook visible again, go to Window | Unhide, and you'll see a list of the hidden 
workbooks. Select the workbook name that you want to display, and click OK. 
 
Don't worry about forgetting that you have a workbook open. If you close Excel while a workbook is 
hidden and you haven't saved your changes, Excel asks if you want to save the changes to any unsaved 
workbooks.  

Quickly shuffling toolbar buttons 
Here's a quick tip you can pass on to your users who like to modify their Excel toolbars. 
Instead of right-clicking a toolbar and selecting Customize to launch the Customize dialog box, they can 
simply press the [Alt] key and click and drag a button to any toolbar they want. Of course, both the source 
and target toolbars must be visible for this procedure to be effective. 
 
One quick word of warning: This technique moves buttons, so they will no longer be on the default 
toolbar. If users want to copy a button to a new toolbar while retaining its position on the original one, they 
can hold down [Ctrl][Alt] while clicking and dragging the button. 

Opening a workbook at startup 
If some of your users spend much of their day working in a specific workbook, you can teach them how to 
designate that workbook to open each time Excel launches. All they need to do is place the workbook (or 
a shortcut to the workbook) in the XLStart folder. This technique also works with network shortcuts. 
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You'll find the XLStart folder in the same place as the Excel program files—typically C:\Program 
Files\Microsoft Office\Office. After placing the file or shortcut in the XLStart folder, the user can just restart 
Excel to see the file pop open automatically. 

Saving time with Custom Views 
Custom Views is a tool in Excel that lets you assign a name to a particular sheet layout so you can recall 
it for later viewing. You can access the feature by selecting View | Custom Views. In the Custom Views 
dialog box, you'll see a listing of saved views, and you can add or delete views. When adding a view, you 
have the option of including print settings, hidden rows and columns, and filter settings. The new view 
even remembers where the active cell was when the view was saved, so when you open that view, it will 
”jump” to the spot in your sheet that corresponds to that view. 
 
Making good use of custom views can save a great deal of time. For example, you can eliminate 
repetitive hiding, resizing, filtering, and other changes for producing various printed reports. Each set of 
options can be saved as a view. Then, all you need to do is apply the view before you print. 

Using shared workbooks 
If you have several users who need to work from the same workbook at the same time, familiarize 
yourself with Excel's Shared Workbook feature. This feature can be a lifesaver when workbooks must be 
updated by multiple users. 
 
To use this feature, select Tools | Share Workbook, and Excel will allow multiple users to edit the 
workbook. You can set options that control when changes are updated and how to handle conflicting edits 
by different users. You can also choose to save updates when a user clicks Save, or you can specify a 
time interval for Excel to automatically save user updates. In the Share Workbook dialog box, you can 
decide how changes should be logged by the Track Changes feature, which integrates with workbook 
sharing. That way, you can see exactly what changes were made to cells, when sheets were added or 
deleted, how conflicting edits were resolved, etc. Users can also see the names of all the other users who 
have the workbook open for editing. 

Clear out all comments 
As handy as comments can be in annotating the information in a worksheet, your users may sometimes 
want to delete them once they've served their purpose. The fastest way to handle this task is to click Edit | 
Go To | Special and then select the Comments option and click OK. Users can then choose Clear from 
the Edit menu and select Comments. Excel will delete all the comments and their text from the current 
worksheet. 

Macro security settings 
If you write macros that other people in your organization use, you should be aware of the Macro Security 
settings in Excel (and in all Office applications). These settings control the messages you receive when 
you open a workbook that contains macros; they ask if it's okay to enable them. 
 
In the good old days, developers didn't have to worry about such things. But with the advent of macro 
viruses, you now need to take such user-level security settings into account when developing code. 
 
In Office 2000/XP, there are three levels of security for macros contained within files: 
 
• High automatically disables any macro not "signed" with a digital signature. It will allow macros to be 

enabled only from sources already deemed to be "trusted." 
• Medium prompts users to decide whether a macro should be enabled. 
• Low does not notify users that files contain macros. All macros are enabled for opened files. 
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The security settings on your users' machines might be dictated by policy or may be up to the user's 
discretion. Either way, the safest action for developers of Office-based macros is to obtain a digital 
signature to sign their macros. With a digitally signed macro, even the High setting will enable your code, 
provided the user approves. 

Take a few shortcuts 
Who doesn't need to save a little time here and there? Keyboard shortcuts can help you do just that. 
Here's a list of shortcuts for Excel that will make life a little easier: 
 
• [Ctrl][Shift]A: Use this combination after typing a function name, and it will automatically enter the 

parentheses and the argument names for the function you typed. 
• [Alt][F8]: Displays the Macro dialog box. 
• [Alt][F11]: Opens the VBA Editor or switches to it if it's already open. 
• [Ctrl]1: Displays the Format Cells dialog box. 
• [Ctrl][Shift][~]: Applies the General format. 
• [Ctrl][Shift][$]: Formats the current cells as Currency. 
• [Ctrl][Shift][#]: Applies the Date format. 
• [Shift][F10]: Displays the shortcut menu that applies to the selection. 
• [F6]: Moves to the next pane in a split worksheet. 
• [Shift][F6]: Moves to the previous pane. 
• [Ctrl][F6]: Moves to the next workbook window. 
• [Ctrl][Shift][F6]: Moves back to the last workbook window. 
• [F3]: Opens a dialog box to paste a Named Range into a formula. 
• [Ctrl][F3]: Opens the Define Name dialog box. 
• [Ctrl][Shift][F3]: Automatically creates Named Ranges from the headers for the selected table of data 

with row or column headers. 
• [Shift][F3]: Inserts an equal sign (=) and opens the Paste Function dialog box to help you pick a 

formula. 
• [Alt][=]: Inserts the AutoSum function. 
• [Ctrl][;]: Inserts the current date. 

Take advantage of the Personal Macro Workbook 
The Personal Macro Workbook is the Excel cousin to the Normal.dot file in Word. It's a file that opens with 
Excel in the background and makes your saved macros available for any open workbook. This workbook 
is one of the options available when recording new macros in Excel. 
 
We recommend saving all macros that will be used across multiple workbooks into the Personal Macro 
Workbook. This will keep things simpler for your users. If they try to save a macro into each workbook 
where it will be used, they'll have a tough job of updating if the macro requires a change. If it's saved in 
the Personal Macro Workbook, it will need to be changed only once. The change will be available across 
all workbooks. When writing macros in the VBA Editor, macros should be saved in Personal.xls. 
Remember to retain this workbook when doing backups. It can be a valuable file once you begin creating 
macros that help in your work. 

Delete personal information from a worksheet 
If you regularly e-mail your spreadsheets to users or copy them to a shared server, you can use Excel 
2002's Options menu to delete any personal information from them before others can see it. 
 
To delete personal information, follow these steps: 
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2. Go to Tools | Options. 
3. On the Security tab, select the Remove Personal Information From This File On Save check box, 

and click OK. 
 
After you save the workbook, Excel will delete the following information from the file: 
 

• File properties (e.g., author, manager, company, etc.) 
• Routing slips 
• E-mail message header 
• Paths associated with downloaded components and smart tags 
• Personal views 
• Name of the last person to open the workbook 

 
In addition, Excel changes names associated with PivotTable reports, comments, and scenarios to 
Author. However, this will not remove personal information contained in macros.  

Editing, layout, and printing 
Hiding duplicate records 
One of the most common mistakes users make in preparing a report or sorting data is including 
redundant entries. For example, if a worksheet keeps a running tally of purchases made by Customer 1, 
there's no need to report cells other than the ones keeping the composite figures. A built-in filter in Excel 
will take care of this problem. 
 
Follow these steps: 
 

1. Choose Data | Filter | Advanced Filter. 
2. Drag across the worksheet to select the lists containing duplicate entries. 
3. Select Unique Records Only. 
4. Click OK. 

 
Excel will now hide any duplicate records in the selected range. 

Copying styles between workbooks 
Creating formatting styles is a real timesaving trick for users. So why should they waste time re-creating 
these styles in multiple workbooks? If they have formatted a workbook in a particularly useful way and 
want to continue to use the format in other workbooks, teach them how to copy the style from one 
workbook to another: 
 

1. Open the source workbook and the destination workbook. 
2. Make sure that the destination workbook is active, go to the Format menu, and choose Style. 
3. Click the Merge button. 
4. Within the Merge Styles dialog box, select the source workbook from the Merge Styles From list 

box. 
5. Click OK. 

Inserting the full file path in headers and footers 
Excel 97 doesn't offer you the option of displaying the full file path in worksheet headers and footers. With 
a little basic VBA editing, you can add this functionality to users' systems. 

Copyright ©2005 CNET Networks, Inc. All rights reserved. 
To see more downloads and get your free TechRepublic membership, please visit 
http://techrepublic.com.com/2001-6240-0.html 

Page 9 of 30 



 75 Essential Excel tips           Version 4.0 

 
1. Go to Tools | Macro | Visual Basic Editor. 
2. Go to the View menu and select Code. 
3. Type the following: 

Sub PathFooter() 
ActiveSheet.PageSetup 
LeftFooter=ActiveWorkbook 
FullName 
End sub 

4. Go to File | Close. 
 
Return to your workbook and save the file. You can now run your macro by navigating to Macros and 
choosing the one named PathFooter. 

Printing formulas 
If your users have invested time in writing numerous formulas, they may want to print them for 
safekeeping. Although Excel doesn't include a simple "Print Formulas" button, functionality is built in. 
Here's how to find it: 
 

1. Go to the Tools menu. 
2. Click Options. 
3. Within the section called Window Options on the View tab, select Formulas. 
4. Click OK. 

 
There is also a keyboard shortcut for this function. Press [Ctrl]~. In both cases, the result is that the 
formulas, rather than their results, will appear in the worksheet. 

Quickly setting a print area 
Your users probably waste a lot of time and paper sending entire worksheets to the printer when all they 
need is a printout of a few columns or rows. Teach them this quick trick to set specific print areas within 
the Print Preview mode: 
 

1. Select View | Page Break Preview. 
2. Select the cells you want to print. 
3. Right-click on the selection and choose Set Print Area from the shortcut menu. 
4. Click Print. 

Print worksheet column labels on every page 
Multipage printouts of large worksheets are difficult to read when their column labels appear only on the 
first page. For example, suppose you have a 10-column, 1000-row worksheet and the labels for each 
column are contained in row one. 
 
Follow these steps to have the column labels print on every page: 
 

1. Click anywhere in the worksheet, and select File | Page Setup. 
2. Click Sheet and, under Print Titles, click the collapse dialog box at the right end of the Rows To 

Repeat At Top text box. 
3. Select a cell in the title row. The range $1:$1 appears in the text box. 
4. Click the collapse dialog box at the right end of the Page Setup--Rows To Repeat At Top text 

box. 
5. Select Print. 
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When you click Print, row one will print as the horizontal title for each page. 
 
To print row labels on the left of each page, follow the steps above, except in Steps 2 and 4, select the 
collapse dialog box at the right end of the Columns To Repeat At Left text box and enter the range of 
columns that contain the row labels. 

Modify Excel print margins with the mouse 
The problem? Your users have more data than will fit within Excel's default margin settings. When they go 
to File | Print Preview, their suspicions are confirmed: Only five out of the six columns are visible. 
advertisement 
 
To correct this by mouse, go to File | Print Preview. If you don't see dotted lines representing margin 
settings, click the Margins button to display them. Mouse over any of the margin lines. When the cursor 
changes to a bidirectional arrow, click and drag to change the margins visually. 
 
In many cases, you can pull that last column back onto the page by shrinking the right and left margins. 
Save even more paper by shrinking the top and bottom margins, cutting a three-page print range down to 
two. 

Don't use AutoFormat on an entire worksheet 
Microsoft has confirmed that there's a potential problem with Excel 2000 when AutoFormat is selected for 
a whole worksheet rather than a specific range. 
 
Depending on your OS and configuration, you could see symptoms ranging from Excel not responding to 
various error messages concerning page faults, low virtual memory, and access violations. 
 
To resolve this issue, make sure that you select only the range of cells you want formatted when you 
select Format | AutoFormat. 
 
Microsoft Knowledge Base article 211478 offers the details of the problem: 
http://support.microsoft.com/support/kb/articles/Q211/4/78.ASP

Keep track of changes 
Track Changes works hand-in-hand with workbook sharing. It keeps a log of all changes to a workbook. It 
tracks cell changes, worksheet additions and deletions, column changes, and other types of changes, as 
well as the date, time, and name of the user who made the change. When data is changed, it keeps a 
record of the old and new values and the exact sheet and cell where the edit was made. 
 
One of the best parts of this tool is the ability to have Excel make a list of the changes in a separate 
worksheet. When this option is selected, Excel builds a listing of each change and even turns on 
AutoFilter to make finding specific changes easy. It also allows you to review each change and either 
accept or reject it. Rejecting a change restores the original value. 
 
To turn on this tool, just select Tools | Track Changes | Highlight Changes. The Highlight Changes dialog 
box provides options such as tracking who makes the change, when the change is made, highlighting the 
change on-screen, and listing the changes. 
 
When using this feature, you might like to see the Summary sheet when you open your workbook. Excel 
removes it when you save the sheet, but you can use this macro to have Excel quickly rebuild it: 
 

Sub ViewChangeSummary() 
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HighlightChangesOptions When:=xlAllChanges 
ListChangesOnNewSheet = True 
HighlightChangesOnScreen = True 
End With 
End Sub 

Express yourself with comments 
We've all opened the workbook from hell. The formatting was a mess, and there were formulas 
everywhere. A day later, you may almost have it decoded enough to work on it. 
 
Get your users into the habit of documenting workbooks with comments. They can enter text descriptions 
into any cell. These descriptions are visible only if you hover the mouse over the cell. A cell with a 
comment is marked with a small red triangle in the upper-right corner. Your users can easily add a 
comment to a cell by clicking Insert | Comment. 
 
Excel's Reviewing toolbar facilitates working with the comments in a workbook. The options on this 
toolbar allow users to add and delete comments and move from one comment to another in a workbook. 
 
With the growing use of teams and collaboration, it's more important than ever to ensure that your users' 
intentions are clearly communicated to everyone who needs to use a workbook. Comments are a good 
way to start. 

Highlight urgent items 
Here's a tip for your Excel users who've always wanted to use the Wingdings font in a worksheet but 
couldn't think of a compelling reason to do so. Suppose they're responsible for maintaining the master to-
do list for their team or department, and they e-mail everyone a copy on a weekly basis. 
 
What can they do to make it easier for everyone to notice the most important items on the lists? If the 
worksheet contains a "severity" or "priority" column, they can make the most important items stand out by 
sorting them to the top of the list. 
 
Or they can introduce a graphical element to their spreadsheet by flagging those urgent items. For 
example, the "lit fuse" icon you get when you format a capital M in the Wingdings font is a good choice. 
 
To try out this trick, type M in a cell. With the cell selected, go to Format | Cells | Font. Choose Wingdings 
from the Font list, select red from the Color list, choose 18 from the Size list, and click OK. The result is 
an icon that's guaranteed to catch the reader's eye when you really want them to pay attention to that 
row.  

Using Goal Seek 
You have a worksheet that has the price of a house, closing costs, and interest rate, and it calculates 
your monthly payment. It works great, but now you want to enter a desirable payment and find the price 
you can afford to get that payment. 
 
This is a common situation when dealing with worksheets (although usually more complex than a simple 
mortgage formula), especially when dealing with projections or forecasts. Goal Seek is just what you 
need for this situation. It allows you to specify a target value for a cell and tell Excel to change the value 
of another related cell to obtain this value. 
 
Highlight the cell you want to change and click Tools | Goal Seek. The cell reference for the selected cell 
will appear in the Set Cell field. Choose a target value and enter it in the To Value field, then specify what 
cell should be changed to meet your target. When you click OK, Excel will attempt to meet your target. 
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Change automatic page breaks 
 
Excel's Page Break Preview feature lets you use the mouse to move, delete, and insert page breaks. 
 
To access this feature from a Normal view, go to View | Page Break Preview, or click the Page Break 
Preview button from Print Preview. This displays an image of the worksheet's print area. Solid lines 
indicate manual page breaks set by the user; dashed lines indicate where Excel will break the page 
automatically. 
 
You can move page breaks, either automatic or manual, by clicking and dragging the break to a new 
location (left, right, up, or down). For example, clicking and dragging the right vertical page break on the 
first page to the right of the first column of the second page will move the column to the first page. 
Microsoft Excel automatically scales the worksheet to fit the new column to the page. 
 
Click a page break and drag it outside the print area to delete it. To insert a new page break, right-click a 
row below or column to the right of the break, and select Insert Page Break. 

Entering and working with data 
Use calculated fields in data entry forms 
One of the easiest ways to enter information into an Excel spreadsheet is to type some column headers 
in row 1, go to Data | Form, and start typing in Excel's default data entry form. This form is a low-tech but 
user-friendly method for entering data. 
 
The problem 
What your users may not know about Excel's built-in form is that it supports calculated fields inasmuch as 
it will copy formulas for them as it enters records. Here's how it works. 
 
The fix 
Suppose your sheet includes four labeled columns (A to D): Customer, Quantity, Unit Price, and Total 
Price. Before you go to Data | Form and start entering records, enter the formula +B2*C2 in cell D2 
(under the label Total Price). Click any of the column labels, and go to Data | Form. 
 
When you do, you'll notice that Excel displays four columns, but you can enter data in the first three only. 
That's because Excel knows you're using the entries in the Quantity and Unit Price columns to calculate 
the value for the entry in the Total Price column. 
 
Excel won't display the result of that calculation dynamically. But as you add records, Excel will copy the 
formula in each new row in column D. If you use the form's Find Prev or Find Next buttons to navigate 
between records, Excel will display the current value of each calculated field as you move between 
records. 

Speed up data entry with these keyboard shortcuts 
Help make your users' data entry easier by teaching them Excel's built-in keyboard shortcuts. For 
example, you can use keyboard shortcuts to copy rows or columns between other cells without 
overwriting. 
 
Follow these steps: 
 

1. Select the rows or columns you want to copy, and press [Ctrl]C. 
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2. Move to the row or column where you want to copy the selected cells. 
3. Press [Ctrl][Shift][+]. 
4. If a dialog box asks which direction you want to shift cells, make your selection, and click OK. 

 
The keyboard can also help you format cells more quickly. For example, after clicking a cell, it takes at 
least two mouse clicks to get to the Format Cells dialog box. But you can also open this dialog box by 
pressing [Ctrl]1. 
 
You can also use shortcut keys to reduce keystrokes. Press [Ctrl][;] to type today's date in a cell, and 
press [Ctrl][Shift][:] to enter the current time. 

Creating custom lists 
Here's another timesaving tip to pass on to your users. If they often make use of the same lists of data, 
you can teach them to create a custom list instead of typing the same information repeatedly. 
For all versions of Excel, if the data is already in a worksheet, follow these steps: 
 

1. Select all of the cells containing the information you want to copy. 
2. Select Options from the Tools menu. 
3. Click the Custom Lists tab. 
4. Click Import. 

 
If you want to create a list from scratch in Excel 97, follow these steps: 
 

1. Go to the Tools menu and choose Custom Lists. 
2. Click in the List Entries box. 
3. Type each item for your list, pressing [Enter] after each item. 
4. When you're finished, click OK to create the list. 

 
To create a list from scratch in Excel 2000/XP, follow these steps: 
 

1. Select Options from the Tools menu. 
1. Click the Custom Lists tab. 
2. Type each item in the List Entries box, pressing [Enter] after each one. 
3. Click Add. 

 
To use a custom list, type the first entry of the list. Use the fill handle at the bottom right corner of the cell 
to drag the whole list across adjacent cells. 

Create a list box to ensure data entry accuracy 
A list box makes it easier for Excel users to avoid errors. For example, a State field requires users to 
know the two-letter abbreviation for each state. To ensure accuracy, let users select from a list. 
 
Follow these steps to create a list for the State field cells: 
 

1. Select all the cells in the State column. 
2. Go to Data | Validation. 
3. On the Settings tab, select List from the Allow drop-down list. 
4. In the Source text box, enter the allowable entries separated by commas as follows: NJ, NY, PA, 

DE, etc. 
5. Select the In-cell Dropdown check box. 
6. Click OK. 
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When users move to a cell in the State column, a drop-down arrow displays. Clicking the arrow reveals a 
list of allowable states users can select for that cell. If users attempt to type an entry that's not on the list, 
Excel displays an error message. 

Increase data entry accuracy with drop-down lists 
Giving users the option to select data from lists rather than type it manually can help eliminate many data 
entry errors. But you don't need to create the actual lists to ensure accuracy. 
 
After users enter an item once, Excel automatically includes it in a drop-down list of entries that users 
previously typed in the column. 
 
For example, to access the list of vendors previously typed in the Vendors column of an Orders 
spreadsheet, follow these steps: 
 
   1. Select the cell under the Vendors column for the next order. 
   2. Press [Alt] and the down arrow. 
   3. Select the vendor's name from the list, and press [Enter] or [Tab] to move to the next cell. 
 
If the vendor's name is not on the list, users must type it manually. Excel will include the name the next 
time someone accesses the list. 

Create a custom Auto Fill list 
The Auto Fill feature can make it easy to enter any data series that frequently appears in your 
spreadsheets. All you need to do is add the series to Auto Fill's built-in lists. 
 
For example, if you report most operations by sales region (e.g., North America, Southeast Asia, Europe, 
etc.), you can create a custom fill series for those regions. Follow these steps: 
 

1. Select a column or row that contains the names of the sales regions. 
2. Go to Tools | Options. 
3. On the Custom Lists tab, you'll see the selected range displayed in the Import List From Cells text 

box. Click Import, and click OK. 
 
Users can now enter all regions by typing one region and using the Auto Fill feature. 
 
You can also use the Custom Lists dialog box to make entries to a new list. Follow these steps: 
 

1. On the Custom Lists tab of the Options dialog box, select New List. 
2. Type each item in the List Entries text box, and press [Enter]. 
3. After you've entered the entire list, click Add, and click OK. 

 

Catching data entry errors 
It's a fact: Shared workbooks generate more errors than workbooks with only one owner. Here's one way 
to flag errors as they occur: 
 

1. Select all cells in which data will be entered. 
2. Go to Format | Conditional Formatting. 
3. In the Conditional Formatting dialog box, specify which cell values to flag. 
4. Click Format. 
5. In the Format Cells dialog box, click the Patterns tab and select a color to signal errors. 
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Now, when someone enters an error, it will be flagged with your selected color. 

Format cells as you type 
Instead of going back to format cells after entering data, use these tips to configure Excel to format the 
cell as you type. 
 
To enter a value in Currency format, type a dollar sign [$] before the value. For example, type $10.00 to 
enter 10 dollars in Currency format. (Don't confuse the Currency format with the format generated by the 
Currency button on the Formatting toolbar, which formats the cells in Accounting format with a dollar 
sign.) 
 
To enter a value in Fraction format, type 0, press the spacebar, and type the fraction (including the slash). 
For example, typing 0, pressing the spacebar, and typing 1/2 enters one-half in Fraction format. 
 
To enter a value in Percentage format, type a percent sign [%] after the value, as in 70%. 
 
You can also format cells as text as you type. For example, if you enter the ZIP code value 08053, Excel 
formats it as the number 8053 by default. To configure Excel to format it as text, enter an apostrophe ['] 
before the value. In this case, typing '08053 formats the cell as the text value 08053.  

Analyzing external data in Excel 
Your users might not know that they can use Excel to analyze data from the various databases in your 
organization. They can use the powerful analytical tools of Excel on data they previously only viewed or 
edited within the database user interface. Using these features, they can pull data from your customer 
database, sales tracking database, product catalog, and HR systems into various sheets in a workbook 
and perform complex pivot table analysis not possible using the separate applications. 
 
This ability is provided by the use of Microsoft Query, an Office application that lives "behind" Excel. You 
can access Microsoft Query by clicking Data | Get External Data. The Query interface is similar to the 
Design view of a query in Access. Point Query at a database, and it will allow you to build complex 
relational queries to pull the necessary data into your worksheet. Now you can build your pivot tables and 
perform your analysis. 

Copy subtotals 
When you apply Data Subtotals, Excel automatically displays outline symbols to the left of the 
spreadsheet. Using these symbols, you can collapse the data to show only the subtotals and the grand 
totals. For instance, you could show the total monthly payroll for each employee, without the weekly 
details. However, when you try to copy and paste the monthly subtotals, both the detail rows and 
subtotals are pasted to the new location. 
 
To copy only the subtotals, use the Go To command with Copy. Follow these steps: 
 
   1. Collapse the subtotals to display only those you want to copy. 
   2. Select the subtotals to copy. 
   3. Go to Edit | Go To, and click Special. 
   4. Select the Visible Cells Only option, and click OK. 
   5. Click Copy. 
   6. Move to the cell where you want to copy the subtotals, and click Paste. 
 
Combining Go To with Copy enables you to copy the subtotals without the details.  
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Summarize data with grouping 
Grouping in Excel allows you to create outline structures with your data. Let's say that you have a column 
of numbers with a cell at the bottom that contains their sum. You could just leave it at that and have other 
worksheet users view the entire column every time they open the workbook. Or you could use Grouping 
to hide the numbers, showing only the sum but providing the option of expanding the outline to see the 
hidden data. 
 
Grouping adds a small column to the left of your data with plus and minus symbols to let users expand or 
hide the detailed data. To build this outline, select the columns of data that will be hidden in your outline 
and choose Data | Group And Outline | Group. Excel will add the expand/collapse symbol to the left of 
your data. Your users can now choose whether to see the source data for the calculations or just the 
totals. 
 
You can choose whether the outline should assume the Totals row is above or below the data. You can 
also use this feature to summarize rows in the same way, so an outline expands or collapses across rows 
instead of columns. 

Data entry solutions with the Template Wizard 
One of the hardest parts of gathering data from users is creating the right collection application. The data 
collection front end is often a series of forms in Access or ASP pages. However, the setup and security 
issues associated with these methods are sometimes too much to deal with for smaller data collection 
needs. 
 
Excel 97 and 2000 ship with an add-in that can help this situation. The Template Wizard with the Data 
Tracking add-in will help you create an Excel template that will accept data from users in a familiar 
environment and then transfer the data to an Access database after it's saved. The wizard will walk you 
through the steps of defining the tables where the data should be inserted. 
 
This is a great solution for such things as purchase order requests, invoices, or expense forms. Your 
users can enter their data in Excel, and the data structures set up by the Wizard will place that data into 
the Access database. The data will be collected into one repository for easy reporting and analysis. 
 
Microsoft Knowledge Base article 214246 explains the process in detail: 
http://support.microsoft.com/support/kb/articles/Q214/2/46.ASP
 
A separate article explains how to use the wizard with Excel 97: 
http://support.microsoft.com/default.aspx?scid=kb;EN-US;148314
 
Excel XP users don't have to forgo this handy add-in, although it doesn't ship with the program. Microsoft 
has made the wizard for Excel XP available for download. 

Simplify data entry with Excel's built-in form 
If your spreadsheet has more columns than can fit on your computer screen, you can use Excel's built-in 
data form and spare yourself a lot of scrolling. 
 
To use the data form, select any cell within the spreadsheet range and go to Data | Form. Select New to 
enter a new record, and Excel will display a blank form. Enter data in the first field, tab to the next, and 
continue to enter data in each field, tabbing between fields. Press [Enter] to go to the next blank record. 
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Follow these steps to search for a record within the form: 
 
   1. Click Criteria to clear the form. 
   2. Enter keywords in appropriate fields (e.g., enter Jones in the Lastname field). 
   3. Click Find Next (or Find Previous). 
 
If you enter search criteria in more than one field, Excel will find the next record that meets both criteria. 
The form doesn't support OR searches. Use the scroll bar to browse through the records.  

Conditional formatting 
Conditional formatting is one of Excel's better features. It allows you to preset certain font styles, colors, 
and cell-background colors based on cell values. This can be very useful for highlighting important 
information and values outside an accepted range or providing a visual cue to associate value ranges 
with color codes. 
 
The best part is that conditional formatting is easy to set up. Just click the cells you'd like to format and 
select Format | Conditional Formatting. The Conditional Formatting dialog box lets you set up the 
conditions by which the formatting of the cell will occur. You pick the operator (between, equal to, less 
than, etc.) and the value or range of values. Click Format to open the Format Cells dialog box, where you 
can select the colors and styles to be used. 
 
Each cell can have several conditional formats. For example, you might say that if a certain cell's value is 
between 20 and 50, the text should be blue on a yellow background. But you can format that same cell to 
exhibit red, bolded text on a green background if it contains a value between 51 and 100. 

Lock cells to prevent overwriting 
You can prevent users from overwriting formulas or inadvertently changing labels or formats by protecting 
those cells. Follow these steps: 
 
   1. Select the cells that users will modify during data entry. 
   2. Go to Format | Cells, deselect the Locked checkbox on the Protection tab, and click OK. 
   3. Go to Tools | Protection | Protect Sheet, and click OK. 
 
Now users will be able to alter only the cells that are unlocked. If users attempt to alter any other cells, 
they will receive a message saying they must unprotect the cells to modify them. 
 
In Step 3, you may wish to add a password to prevent unauthorized users from changing a cell's 
protection level, rather than accepting the default settings.  

Point to value thresholds in a cell 
You can use conditional formatting to alert you to significant changes in cell values. For example, in a 
worksheet that tracks students' grades, conditional formatting can draw attention to quiz averages that 
have fallen below a passing grade of 60 percent. 
 
To apply conditional formatting so average values below 60 percent are displayed in red, follow these 
steps: 
 

1. Select the cells you want to format. 
2. Go to Format | Conditional Formatting. 
3. Under Condition, choose Cell Value Is. 
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5. Click Format and change the font color to red. 
6. Click OK twice. 

 
When you return to the spreadsheet, all averages below 60 percent will be displayed in red. As future 
grades are entered, the format of the cells with the students' average grade will change accordingly. You 
can apply other conditional formatting rules by clicking Add in the Conditional Formatting dialog box. 

Ensure proper data entry with validation 
Data validation rules in Excel automatically check an entry made by a user against rules you have preset 
in the worksheet. This is helpful when you have formulas that depend on certain expected input from the 
user. These formulas can often return errors if the format of the entered data is wrong. 
 
To set data validation rules, select Data | Validation. The dialog box allows you to pick a data type to 
require and a range of values to accept. In the Input Message tab, you can choose to display an 
instructional message when the cell is selected. This message appears in a pop-up, note-style display. It 
can be used to provide users with information about what data you expect them to enter. You can also 
provide a message from the Error Alert tab if the data entered does not meet your rules. 
 
Don't assume that your users will enter the data you expect. If your worksheet functionality depends upon 
consistent data entry, look into using data validation. 

Convert European currencies to Euros 
You can use Excel 2002's Euro Currency Tools to convert worksheet values or formulas from their former 
European currency value to their Euro equivalent. To use these tools, first add the Euro Conversion 
command to the Tools menu. Go to Tools | Add-Ins, select the Euro Currency Tools check box under the 
Add-Ins Available box, and click OK. 
 
If the add-in has been installed, Excel will add the Euro Conversion command to the Tools menu. If it 
hasn't been installed, Excel will ask you to install it. Once installed, return to the Add-Ins dialog box, and 
repeat the above procedure to load the program. 
 
Follow these steps to convert currency values to Euros: 
 

1. Go to Tools | Euro Conversion, or click the Euro Conversion button in the Standard toolbar. 
2. Under Data To Euro Convert, click the Source Range text box, and select the cells in the worksheet 

that you want to convert. 
3. Click the Destination Range text box, and select the upper left cell of the range where you want 

Excel to paste the converted values. (Note: The destination range must be located outside the 
source range.) 

4. Under Currency Conversion, select the currency of the values in the Source Range from the From 
drop-down list. 

5. Select EUR--Euro from the To drop-down list. 
6. Select the Output format, and click OK. 

 
The Euro equivalents are now displayed in the destination range. If you need to convert Euros to their 
former European equivalents, follow the same procedure, but select EUR--Euro in Step 4, and select the 
currency to which you want to convert in Step 5. 
 
If you don't see the Euro Conversion command on the Tools menu or the feature doesn't work as 
expected, refer to the Troubleshoot Euro Currency Conversion item in the Help file. 
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Check for numbers stored in a text format 
Excel can't perform calculations on cell values formatted as text, such as number values that you've 
imported as text from other databases into Excel. Excel 2002 includes a feature that alerts you to these 
cells and optionally converts them to numbers. 
 
To activate this feature, follow these steps: 
 

1. Go to Tools | Options. 
2. On the Error Checking tab, select the Enable Background Error Checking and Number Stored As 

Text check boxes, and click OK. 
 
Now, when Excel finds a number in a cell formatted as text, it will place a green error indicator in the 
upper left corner of the cell. To convert cells to a number format, select the cell, click the Error Checking 
Options button displayed to the left of it, and select Convert To Number.  

Create a template 
As with Word, you can create a template in Excel for frequently used worksheets. For example, suppose 
that you create a new worksheet each month to record the total number of volunteer hours worked in your 
organization. Rather than re-create the worksheet, you can delete the text and numbers entered for the 
month and save the format and formulas to a template. 
 
Follow these steps: 
 
   1. Go to File | Save As. 
   2. In the Save As Type text box, select Template from the drop-down list. 
   3. Enter your template's name in the File Name box, and click Save. 
 
Excel saves the template to the Templates folder with an .xlt file extension. To use the template, go to 
File | New and double-click the template's icon. 
 
To make changes to your template, go to File | Open and select the Templates folder from the Look In 
drop-down list. Select and open your template, make your changes, and click Save. The next time you 
access your template from File | New, the document will include the updates you made to the template. 

Formulas, functions, and code 
Use natural language formulas 
 
You don't need to use cell names to build formulas. You can take advantage of Excel's support for natural 
language formulas to use label names instead. For example, suppose you had three columns of data 
labeled Region, Sales, and Percent of Sales. Below that, you have four rows, one row for each region, 
labeled East, West, North, and South. The next row is labeled Total Sales. 
 
To find the total sales for all four regions using labels, you would enter =SUM(Sales). To find the Percent 
of Sales for the East region, you would use the column and row names as follows, inserting a space 
between the individual label names: 
 

=Sales East / Sales Total Sales 
 
Likewise, the entries for the remaining regions would be: 
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=Sales West / Sales Total Sales 
=Sales North / Sales Total Sales 
=Sales South / Sales Total Sales 

 
As with any Excel formula, you can use the autofill feature to copy natural language formulas. In this 
case, to avoid a Division By Zero error, before copying, make the divisor absolute by selecting the divisor 
Total Sales and pressing [F4]. 
 
If you're using Excel 2002, the natural language formula feature is turned off by default. To turn it on, go 
to Tools | Options, click the Calculation tab, and select the Accept Labels In Formulas check box. 

Exceeding the 30-argument limit 
Excel has a 30-argument limit for statistical functions. It's easy to get around, though, if you group some 
of your arguments within parentheses. 
 
Instead of entering AVG(A1,A2,A3…,A33), you can enter AVG((A1,A2,A3)A4…,A33), and Excel will 
accept the grouped arguments as a single argument within the formula. 

Counting the days via cell subtraction 
By default, Excel 97 adjusts the display of dates to friendly displays that users can identify. But behind the 
scenes, Excel still thinks in numbers. So finding the number of days between two days is as easy as 
simply subtracting one cell that contains a date, regardless of format, from another date-carrying cell. 
 
For example, let's suppose a user has entered the date 2/20/2000 in cell A1 and 3/10/2000 in cell A2. The 
formula A2-A1 will return the result 19 (2000 was a leap year). Note: You must use the date that falls later 
in the calendar year as the first argument of the equation, or the equation will return an error. 
 
By default, Excel will format the result of a formula in the same format as the source cells. So in our 
example, it reports that the difference between 2/20/2000 and 3/10/2000 is 1/19/1900. However, simply 
right-clicking the formula cell, selecting Format Cells, and selecting a Number format will fix this problem. 

Compare values in text fields using DCOUNTA 
Excel's DCOUNTA function finds and counts the number of records that meet specific criteria, such as 
how many employees were hired before Jan. 1, 2000, or how many customers live within the 08053 ZIP 
code. 
 
For example, to find out how many people in an employee spreadsheet live in the state of New York, 
follow these steps: 
 

1. Insert two blank rows above the range, and copy and paste the column headings into the first blank 
row. 

2. In the second blank row, enter New York in the cell under the State field. 
3. In another cell outside the criteria range, enter =DCOUNTA( 
4. Type the range or named range. For example, if the range is named Employees, enter that name 

as the first argument to the formula: =DCOUNTA(Employees, 
5. Type the field name that you want counted. For example, if you want to count the number of 

records that have an entry in the Last_name field and whose City field contains the text "New York," 
enter: =DCOUNTA(Employees,"Last Name", 
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The total number of employees living in New York will be displayed. 
 
Now that the criteria range has been set, you can use DCOUNTA for other ad hoc reporting functions; 
just enter different criteria. 

Converting Julian dates 
Here's a little piece of post-Y2K calendar trivia for you. Since the 1950s, astronomers and geophysicists 
have used Julian dates to track time in continuous, absolute terms, without bothersome seasons, leap 
years, or man-made conventions. Julian dates associate a date with the number of days elapsed since 
January 1 of the same year. (For example, Jan. 2, 2000, has the value of 2.) 
 
Excel doesn't have a built-in option to convert dates to Julian time, but you can use this shortcut to 
convert today's date to the Julian format. 
 
Just type this equation into any cell in your worksheet: 
 
=VALUE(RIGHT(YEAR(TODAY()),2)&TEXT(TODAY()-DATE(YEAR(TODAY())-1,12,31),"000")) 
 
Now, you'll need to format this value to display five digits. 
 

1. Right-click in the cell that contains the value and select Format Cells. 
2. On the Number tab, choose Custom from the Category list box. 
3. In the Type text box, enter 00000. 
4. Click OK. 

Use the Immediate window 
One of the tools provided by the VBA Editor is the Immediate window. You can use it as a general-
purpose scratch pad while testing your code. For instance, you can place Print commands at various 
places in your code to output variable values or the results of calculations to this window. For example: 
 

For Count = 1 to 20 
     Debug.Print Count 
Next Count 

This code prints the numbers 1 through 20 to the Immediate window. 
 
You can use the Immediate window to check or change variable values or object properties to test the 
results on your running code. You can also call other procedures from this window. For example: 
 

Debug.Print A * 125 
 
multiplies the current value of the variable A by 125 and prints the results in the window. 
 

Activesheet.Name = "New Name" 
 
changes the name of the active sheet. 
 
The Immediate window offers an excellent way to test the outcome of new values or property changes on 
your code without inserting the new code into your procedure. 

Perform calculations with Paste Special 
Most Excel users know how to convert formulas to values with the Paste Special function. This function 
also makes it easy to perform mathematical operations on a range of cells "in place." 
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Let's say you've entered some numbers in a range of cells, and now you want to double those values. 
You could write a formula elsewhere in the sheet that multiplies the values in the original cells by two, 
copy the cells with the formulas, and use Paste Special | Values to overlay the new values in the original 
cells. However, you'd have to delete the work cells that contained the doubling formula. 
 
To eliminate this extra step, follow these steps: 
 

1. Select the cells whose values you want to double, and press [Ctrl]C. 
2. Go to Edit | Paste Special. 
3. Select Add in the Operation section, and click OK. 

 
Excel adds the values you copied to the values contained in the target cells, which doubles the original 
values. 
 
This feature is also useful when you want to update a range of cells using the values from a completely 
different range of cells. Just select and copy the first set of values, click the first cell in the target range, 
and go to Edit | Paste Special. From there, select Add, Subtract, Multiply, or Divide, and then click OK. 
Excel will update the target cells with the calculation results.  

Use auditing to troubleshoot 
We've all clicked a cell to see the formula, wanting to find out where the result came from, only to find a 
formula that went on forever. It has everything: nested functions inside of conditionals, pulling data from 
cells all over the workbook. Just when you think you'll never figure this monster out, you remember 
Excel's Auditing features. 
 
Select the cell containing the complex formula and click Tools | Auditing | Trace Precedents. (In Excel XP, 
choose Tools | Formula Auditing | Trace Precedents.) Excel will draw blue arrows from every cell the 
formula references to the cell containing the formula. Now you can see where that data is coming from. 
 
Auditing also allows you to select a cell containing a value and choose Trace Dependants, which will 
draw arrows from the cell to all the cells containing formulas that reference that value. 
 
And if you have a cell that shows an error value, you can select it and choose Trace Error. Excel will 
show you all the cells that contribute to the error. 

Customizing "division by 0" error messages 
Working in a complex worksheet, you may have encountered that annoying "#DIV/0!" error when the 
divisor of your formula is a zero. Using the built-in IF function, you can create your own message for 
display when you divide by zero: 
 
=IF (DIVISOR = 0,"Your Text", DIVIDED/DIVISOR) 

The IF function evaluates the first parameter (DIVISOR = 0). If it's TRUE, it places the second parameter 
("Your Text") in the cell. If it's FALSE, the function places the third parameter (DIVIDED/DIVISOR) in the 
cell. 
 
This helps you control the message that's displayed when your formula produces a zero value that is then 
used to divide another value. 
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Hide formula cells from users 
Excel's Protect Sheet capability can prevent users from changing cells, and it can hide formulas from 
view. For example, say you want to give users the ability to enter data in a worksheet for analysis, but you 
want to keep the proprietary formulas used in the analysis from being visible. 
 
By default, the Protect Sheet feature locks all cells from data entry. To unlock cells for data input, follow 
these steps: 
 

1. Select the cells for data input, and click Format | Cells. 
2. On the Protection tab, deselect the Locked check box, and click OK. 

 
To hide formulas from view, follow these steps: 
 

1. Select the formula cells you want to hide, and go to Format | Cells. 
2. On the Protection tab, select the Hidden check box, and click OK. 
3. Go to Tools | Protection | Protect Sheet, and click OK. You can also set a password to prevent 

others from unprotecting the sheet. 

Debugging your code 
A great way to find errors in your code is to step through it one line at a time. The Step Into button on the 
Debug toolbar in the VBA Editor lets you do this. 
 
To start your macro, just click Step Into on the toolbar. The VBA Editor will work through each statement. 
This allows you to take advantage of some of the other debug tools, such as the Locals window and the 
Watchwindow. 
 
When stepping through your code, you can use the Step Out command to run the remaining code as 
normal. So even if you stepped through half the macro one statement at a time, you can then run the last 
half normally by clicking Step Out. 

Debugging using watches 
You've just spent over an hour writing just the macro you need. It's the one that will make your life easier, 
and you just got it right—or so you thought. But now it's providing the wrong data output, and you can't 
figure out why. All the code looks right. 
 
One of the great debug tools in the VBA Editor is called a watch expression. Watch expressions allow you 
to see the values of the variables in your macro at any given time. You can use them with the Step 
commands to walk though your code. These values can be a big help in finding out why your macro is 
generating the wrong data. You can use the watch expressions to see your variable values and then 
compare them to what they would be if your macro were working correctly. 
 
To access the Watch window, just click View | Watch Window in the VBA Editor. To add a watch, right-
click a variable and select Add Watch from the shortcut menu. This brings up a dialog box that gives you 
options about the new watch. 

Create an Outlook message from Excel 
The ability to create objects from other Office applications is one of the great things about using VBA. For 
example, you can write a macro that will create an Outlook message object and attach a shortcut to the 
currently open workbook. A button on the toolbar will perform this same action, which is fine if that's all 
you want to do. But using the sample macro below, you can add other text to the message, pre-address 
it, or perform other actions. You can also tie the creation of the message to some other user action. For 
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instance, you could automatically send a message to certain people if the user saves the workbook and if 
the values of certain cells match criteria you set—all without any user interaction. This sample macro will 
get you started in the right direction: 
 

Sub CreateOutlookMail() 
 Dim olApp    As Outlook.Application 
 Dim olMailMessage  As Outlook.MailItem 
  
 ' Create new instance of Outlook or open current instance. 
 Set olApp = New Outlook.Application 
 ' Create new message. 
 Set olMailMessage = olApp.CreateItem(olMailItem) 
 With olMailMessage 
  .Subject = "Testing mail by Automation" 
  .Body = "This message was created by VBA code running Outlook through Automation." _ 
  & Chr(13) 
  .Attachments.Add Application.ActiveWorkbook.Path & "\" & _ 
  Application.ActiveWorkbook.Name, olByReference 
  
  .Display 
 End With 
 Set olMailMessage = Nothing 
 olApp.Quit 
 Set olApp = Nothing 
End Sub 

Troubleshooting 
Detect And Repair 
Microsoft Office 2000 programs, including Excel, contain a command line called Detect And Repair, which 
checks and fixes problems with Office program files, DLLs, and registry settings. (This utility does not 
affect worksheets or other document files.) 
 
Detect And Repair, which you access as a command line option of the Setup utility, performs the 
following actions: 

• Reinstalls Office .exe and .dll files if missing, out-of-date, or corrupt 
• Reinstalls all Windows Installer shortcuts, overwriting any existing shortcuts 
• Rewrites all required local machine registry values 
• Rewrites all required user registry values 

 
You can run Detect And Repair from within Office, but that won't do much good if a serious error is 
preventing your user from even launching an Office application. Fortunately, you can run the utility from 
the Run dialog box with the following entry: 

drive:\setup.exe /focums install.msi 

User-level prevention is a magic cure 
Every support pro knows that most of their problems could be avoided if their users would just follow a 
few simple, common sense precautions. If you keep getting calls on corrupted Excel documents, pass 
around this list of Microsoft-endorsed tips to help users keep their data safe and make your days a little 
less stressful: 
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• Move radios, fax machines, televisions, stereos, speakers, and other sources of electromagnetic 
radiation away from computers. 

• If your users are still using floppies, make sure they are not putting them on top of their monitors. 
• Regularly run Norton AntiVirus or another utility to scan for viruses. 
• Store floppy disks in a disk storage container. 
• Don't be a slob—prevent dust from building up around your computer. 
• And, most important, exit Windows before restarting or shutting down a client system. 

Recovering data with the SYLK format 
If a user complains of being unable to save a workbook, the problem is usually user error. However, 
things do go wrong. If you've tried all the common sense remedies and the workbook does seem to be 
corrupted, you can try to revert to the old Symbolic Link (SYLK) format. 
 
This approach will let your users recover most of their essential data by stripping away the more complex 
information that tends to be the source of corruption. Unfortunately, this trick won't help them get back 
any data, including charts and graphics, that was not supported back in the days of Excel 2.0. 
 
Follow these easy steps in Excel 97: 
 

1. Open the file that appears to be corrupted. 
2. Select Save As from the File menu. 
3. In the Save As Type list, select SYLK (Symbolic Link). 
4. Click Save. 
5. Click OK in the warning dialog box that appears when you save in SYLK format. 
6. Close the file. 
7. Click No to move on past the warning that the file you are closing is not in the normal Microsoft 

Excel format. (Clicking Yes will resave the file in the normal Microsoft Excel format.) 
8. Select Open from the File menu. 
9. Select All Files (*.*) in the Files Of Type drop-down list. 
10. Select the SYLK file you saved in step 3 and click Open. 
11. Select Save As from the File menu. 
12. Select Microsoft Excel Workbook (*.xls) in the Save As Type drop-down list. 
13. Click Save. 

 
For additional information, check out Microsoft Knowledge Base article 45557: 
http://support.microsoft.com/support/kb/ARTICLES/Q45/5/57.asp

Update for Excel 2000 text export 
Microsoft has released a patch that fixes a formatting problem when exporting Excel 2000 files to .txt 
documents. On machines running a Microsoft OS earlier than Windows 2000, four-digit year entries are 
automatically truncated to two-digit entries, regardless of formatting applied within Excel. 
 
This behavior occurs only when users employ a macro or procedure to export to a text file, not during 
manual saves to a text file format. If your users are using Visual Basic for Applications to export files to 
.txt, .prn, .csv, or .dif formats (and you are using a pre-Windows 2000 OS), you need to install an update 
released by Microsoft. For more information, read the Microsoft Knowledge Base article 247796, XL2000: 
Programmatically Exporting Text File Truncates Dates: 
http://support.microsoft.com/support/kb/articles/Q247/7/96.asp
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Beware of sharing dates between Excel for Windows and Excel for Macs 
Excel supports two data systems: 1900 and 1904. Early Macintoshes did not support dates before Jan. 1, 
1904. For this reason, Excel for Macs renders entered dates as the number of days since 1/1/1904. Excel 
for Windows, on the other hand, supports dates starting Jan. 1, 1900, and so renders dates as the 
number of days since 1/1/1900. 
 
For example, the date 1/1/1904 is represented as a 0 in the 1904 date system. The same date in the 
1900 date system is represented by the number 1,462. This is because 1/1/1904 is 1,462 days since 
1/1/1900, the day the 1900 date system begins its "counting." 
 
What all this means to you is that if you have users on both Macs and PCs using Excel and copying data 
between workbooks, there's the chance of incorrect date representation. 
 
One solution is to set your PCs so that they all use the 1904 date system. Then they'll be compatible with 
the Macs. To do so, open a workbook and select Tools | Options. Click the Calculation tab. Under 
Workbook Option, select the 1904 Date System check box and click OK. For more information, check out 
Microsoft's Knowledge Base article 214330, which covers this issue in depth: 
http://support.microsoft.com/support/kb/articles/Q214/3/30.asp

Repairing broken file type associations 
How many times has one of your users mysteriously lost his or her file associations, requiring you to go to 
the File Types tab and re-associate Excel (or Word and PowerPoint) to the .xls and .xlt file types? 
 
There's a faster way to fix Office file type associations, and it takes just one quick step. Using the 
/regserver command line switch will make Excel reregister itself and rewrite all its registry entries, 
including its file type associations. You can reset all your users' file extensions for Excel, Word, 
PowerPoint, and Access using this same method. 
 
From the command line, type C:\Program Files\Microsoft Office\Office\Excel.exe /regserver. You can also 
modify a shortcut to Excel by adding /regserver after the end quotes in the Target field of the Shortcut tab 
on the shortcut's Properties sheet. 

Ask Mr. Excel 
Excel power users and support pros: Check out MrExcel.com. Mr. Excel answers one reader's question 
per week, according to what piques his interest, often including full macros to be copied and put to use. 
 
Because this is a side project for the site's operator, he can't answer every question submitted, but he has 
provided a message board for other Excel users to exchange information. Other site features include past 
week's tips, quick answers, book reviews, and the opportunity to find out whether you can answer the 
monthly challenge. 
 
If you work extensively with Excel and Visual Basic, this may be the one resource you've been looking for. 
http://www.mrexcel.com

Web tricks 
Easy data-posting to the Web 
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If your organization is using an intranet to share public data—and whose organization isn't these days—
your users will want an easy way to post this information. Excel 97 offers an easy, wizard-driven system 
to walk even the most apprehensive users through this process: 
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1. Select the cell range that contains the data to be published. 
2. Select Save As HTML from the File menu. 
3. Answer the questions posed by the Internet Assistant Wizard. 

 
The wizard walks users through four steps that define how information will be converted for Web display. 
Various options include: 

• Inserting the resulting HTML tables into an existing HTML page or creating an entirely new page. 
• Specifying formatting options, such as rules between data. 
• Saving the new HTML page as a freestanding file or inserting it directly into a FrontPage Web. 

Open Web pages right in Excel 
If your users need to analyze data found on a Web site, they might be in for a bunch of tedious retyping. 
Under the right circumstances, however, Excel 97 can save them a lot of time by letting them open an 
HTML page in Excel directly from the Web. 

The procedure is just a slight modification of the standard file-opening procedure: 
 

1. Choose Open from the File menu. 
2. In the File Name text box, type the URL of the Web file to open. Note: Be sure to include the 

prefix http://. 
3. From the Files Of Type drop-down list, select HTML Documents (*.html, *.htm). 
4. Click Open. 

Excel opens HTML pages based on the HTML table structure of the page, so some Web design 
treatments may lead to some weird results in Excel. For pages that cleanly present data in a table format, 
however, this approach can be a real time-saver. 

Web Publishing Wizard Error with Office 2000 
When trying to run the Setup utility after your initial Office 2000 setup, you may receive the following 
error: 
 

Insert Disk 
The file 'Crswpp.dll' on Web Publishing Wizard disk cannot be found. 
Insert Web Publishing Wizard disk in the selected drive, and click OK. 

 
Further efforts to run Setup will produce similar errors. 
Microsoft has identified the problem as being connected to the installation of some modem hardware. 
Fortunately, clicking Cancel when you receive this error message will usually prompt Setup to run 
successfully with no harmful effects. 
 
For more information about all the causal factors, including a complete description of the problematic 
modem hardware and possible resolutions, check out Microsoft Knowledge Base article 234688: 
http://support.microsoft.com/support/kb/articles/Q234/6/88.asp

Hyperlink to a specific cell 
Did you know that you can create a hyperlink from a Web page on your intranet or the Internet to a 
particular sheet, range, and cell in an Excel workbook? For example: 
 

<a href="http://yourwebserver/hyperlinktesting 
.xls#Sheet1!A1">Link Test </a> 

will open your file called Hyperlinktesting.xls and then select cell A1 on Sheet1. 
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Using this kind of linking, you can specify exactly where your user will enter the workbook. Users' views of 
the workbook won't be bound by the state at the last save. 
 
This can be helpful if you insert the link to a Web page that asks the user to enter data in a particular cell 
or area of a sheet. You can select the cell for them when they click the link. 
 
For information on linking to Excel 97 worksheets, see Microsoft Knowledge Base article 172503: 
http://support.microsoft.com/default.aspx?scid=kb;EN-US;172503
 
For details on linking to Excel 2000 worksheets, see Microsoft Knowledge Base article 211693: 
http://support.microsoft.com/support/kb/articles/q211/6/93.asp
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